Creating a help desk web application using ASP.NET
You work for a small to medium size company that employs 50-100 personnel. Currently, the help desk, a subsidiary of Information Services is in charge of trouble tickets, regarding general pc issues such as email, viruses, network issues, etc. At the moment, they store this information in excel spread sheets. As the company has grown, managing these spread sheets has become tedious and time consuming. You as the developer for the company have been contacted by the help desk to see if there’s a more efficient solution that could be developed internally saving the company money. Obviously, there are plenty of solutions available, but if you’re experienced with the web, creating an internal help desk web application with ASP.NET is relatively simple.
As you start to think about it, the following requirements are apparent: submitter’s first, and last name, as well as their email address. We’ll also need combo boxes that lets the submitter choose severity (low, medium, high), department, status (new, open, and resolved), employee working on the issue, and an area for comments. In the following article, we’ll see how to implement these features using a database driven approach, while keeping maintenance and scalability in mind. If you would like to learn how to implement a web application like this, please follow along.
http://midwestwebdesign.net/tutorials/aspnetthelpdesk/aspnethelpdesk.zip
Requirements
To follow along with this article, you’ll need Visual Studio 2008 or Visual Web Developer, and SQL Server 2005 or 2008.

Create the database
From the desktop, follow these steps to open SQL Server:

· Start>Programs>SQL Server <ver>

Where <ver> is your version of SQL Server; from there, connect to your local database server. Once connected, create your database by following these steps:

· Right click on databases and select New database as shown below:
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· Give your database a name of mwd and click OK

Create the main table
To create our tables, follow these steps:

· Click the plus (+) sign next to your database as shown below:
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· Right click on Tables, and select New Table as shown below:
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Let’s create the main table, helpdesk first. We need the following columns as outlined below:

· ID

· Primary key

· Data type: int

· Not null

· FName
· Data type: varchar(50)
· Null

· LName
· Data type: varchar(50)
· Null

· Email

· Data type: varchar(50)

· Null

· SeverityID

· Data type: int

· Null

· StatusID
· Data type: int
· Not Null

· DepartmentID

· Data type: int

· Not null

· EmployeeID

· Data type: int

· Null

· Comments

· Data type: varchar(50)

· null

Before continuing, make sure to set the primary key by right clicking the column and choosing primary key as shown below:
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While we’re at it, let’s set the seed on this column as well by setting Identity Specification to Yes as shown below:
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Create child tables
We’ll explain why we need four additional tables shortly, but let’s go ahead and create the severity, status, department and employee table using the same steps as outlined above, just change table column names as outlined below:
Severity
· ID

· Primary key

· Data type: int

· Not null

· Severity
· Data type: varchar(50)

· Null

Status

· ID
· Primary key

· Data type:int

· Not null

· Status

· Data type: varchar(50)

· Null

Department

· ID
· Primary key

· Data type:int

· Not null

· Department
· Data type: varchar(50)

· Null
Employee

· ID

· Primary key

· Data type: int

· Not null

· FName

· Data type: varchar(50)

· Null

· LName

· Data type: varchar(50)

· Null

Make sure you set the primary key and seed on the ID columns for these tables as well.
Relational databases
When learning about databases, one of the toughest concepts to understand is the idea behind relationships in data. In relational databases you don’t want to duplicate data, and you especially don’t want to leave your database vulnerable to scalability or maintenance issues. We get around this through relating our data to other tables. This way, you don’t duplicate data and your database remains scalable and the maintenance pain point is usually reduced.  
For example, think of a family hierarchy tree. Let’s start with the parents:
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The parents have children:
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As you can see, the children are related to each other as brother and sister, and they are also related to each parent. So in our example, mom and dad (parents) is our parent table, while the children are our children table(s). As a result, we know these tables are related through DNA. Using our example above, we can think of the help desk table as being our parent table, while our additional tables can be thought of as our child tables. The only difference is they are related through a primary – foreign key.

By creating four additional tables we can store a reference or relationship of these records in our help desk table. By doing this, we eliminate the following:
· Duplicate data, since help desk will hold a unique key reference (foreign key) to each status, department, severity and employee that comes from each parent table.
· Scalable and maintenance has been reduced. If an employee or department changes, you change the details in the employee or department tables (children), and the unique reference in help desk (parent), automatically reflects that change.

· You enforce referential integrity of the records, ensuring that a delete from department or employee doesn’t adversely affect any records in helpdesk.

Let’s use an illustration to help visualize the relationships in the data:
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Create a database diagram
In order to enforce referential integrity on our database, let’s create a database diagram by following these steps:
· Right click Database diagrams and select New Database Diagram as shown below:
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· In the Add table window, select severity, department, employee, status and click add as shown below:
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Place the helpdesk table in the middle, with status in the top left, department in the bottom left, severity in the top right, and employee in the bottom right as shown before the section Create a database diagram.
From this point, follow these steps:

· Left click the ID column in status and drag to the status id column in help desk. In the window that prompts, make sure your settings are as shown below and then click OK:
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· Repeat this process for department, severity and employee, choosing where appropriate column names where appropriate.
· In the database diagram window, press Cntrl + S on your keyboard, and give your diagram a name, such as help desk
Populating severity, employee, department, and status tables
Let’s go ahead and populate these tables with some data by following these steps:

· Right click on severity, and select Open

· Enter the following data:

· Low
· Medium

· High

· Continuing, right click on employee and select Open

· Enter the following data:

· Record 1

· FName>Jeff

· LName>Jones

· Record 2

· FName>Monty

· LName>Python

· Right click on department and select Open

· Enter the following data:

· IT – Development

· IT – Support

· IT – Database

· Right click on status and select Open

· Enter the following data:

· New
· Open
· Resolved
Minimize SQL Server Management Studio; we’re done with it for the time being.

Open Visual Studio and create the project
Let’s go ahead and open Visual Studio from the desktop by following these steps:

· Start>Programs>Microsoft Visual Studio

From the main menu, create a new project by following these steps:
· File>New>Project

· In the New Project window, under the Visual C# tree, choose Web, then ASP.NET Web Application

· In the name text box, name our project HelpDesk
· Leave Create a directory for solution checked

· Click OK

Once the project is created, you’ll have one ASPX file and a web.config. 
Open web.config
From the solution explorer, double click web.config and look for <connectionStrings>. Replace the default markup with the following as shown below:
<connectionStrings>
<add name="mwd" connectionString="Data Source=P425\SQLExpress;Initial Catalog=HelpDesk;Integrated Security=SSPI;"/>

</connectionStrings>
Simply replace the value inside the double quotes for connection string with your settings. Once completed, save your file.

Open default.aspx
From the solution explorer, double click default.aspx and replace everything inside the opening and closing <form runat= "server "> tag with:
<body>

<asp:PlaceHolder ID="phForm" runat="server" Visible="true">

<form id="form1" runat="server">

</form>

</asp:PlaceHolder>

<asp:PlaceHolder ID="phSuccess" runat="server" Visible="false">

<p>Ticket submitted successfully.</p>

<p><a href="Default.aspx">Submit another ticket</a></p>

</asp:PlaceHolder>

</body>
As you can see from the code above, we nested two place holder controls inside our form tag. A place holder control is identical to any other ASP.NET control in that it’s ran server-side, the only difference is whether it will show or hide the content inside. The control is made up of the following:
· ID

· Gives our place holder a unique name

· Runat

· The control will be run by the web server first, and then resulting HTML output will be sent to the browser

· Visible

· Sets the visibility of our control to true, meaning it will show initially

The second place holder control simply is a success message. We’ll see how this works a little later.

Create the style sheet
· From the solution explorer, right click our project name and choose Add>New Item 

· From the Add New Item window, select Style sheet
· In the name text box, type style.css and click OK

Create the markup
In order to focus a bit more attention to the code, and other new aspects in this article, let’s just copy and paste the markup below:
<form id="form1" runat="server">

<div class="row">

<label for="firstName">First Name:</label>    

<asp:TextBox ID="fnameTB" runat="server" />

</div>

<div class="row">

<label for="lastName">Last Name:</label>

<asp:TextBox ID="lnameTB" runat="server" />

</div>

<div class="row">

<label for="email">Email:</label>

<asp:TextBox ID="emailTB" runat="server" />

</div>

<div class="row">

<label for="severity">Severity:</label>

<asp:DropDownList ID="ddlSeverity" runat="server" />

</div>

<div class="row">

<label for="status">Status:</label>

<asp:DropDownList ID="ddlStatus" runat="server" />

</div>

<div class="row">

<label for="department">Department:</label>

<asp:DropDownList ID="ddlDept" runat="server" />

</div>

<div class="row">

<label for="employee">Assigned to:</label>

<asp:DropDownList ID="ddlEmp" runat="server" />

</div>

<div class="row">

<label for="comments">Comments:</label>

<asp:TextBox ID="commentsTB" runat="server" TextMode="MultiLine" />

</div>

<div class="row">

<asp:Button ID="btnSubmit" runat="server" Text="Submit" OnClick="btnSubmit_Click" />

<asp:Button ID="btnClear" runat="server" Text="Clear" OnClientClick="clear_Fields();" />

</div>

</form>

As you can see from the code above, we added div tags with a class name of row for each row of data. Couple important areas to note are: the two button controls at the end, serve two different purposes. Our first button, for submission of the help desk ticket, has a server-side event handler, which is denoted by the onClick attribute. This means, the event handler for this button will be placed in the code behind file of default.aspx. Our second button, is to reset our form fields to their initial values. We could reset them using a server-side event, but that’s an unnecessary server-side event that we don’t need. As a result, we have used a client-side event handler, which is denoted by the OnClientClick attribute. This means, the event handler for this button will be placed in a JavaScript file and only be ran on the client.
Let’s add the needed CSS as shown below:

body

{

}

label{



float:left;



width:200px;



margin:6px;

}

#form1{



width:420px;



margin:0 auto;

}

div.row{



clear:left;

}

#commentsTB{



width:200px;



height:100px;

}
In our default.aspx page, add the reference to our style sheet as shown below:
<head runat="server">

<title></title>

<style type="text/css" media="screen">

@import "styles.css";

</style>

If you haven’t saved your file(s) yet, now would be a good time to do so.
Creating the JavaScript file
Since this is the easiest of the work left, we’ll do this next. From the solution explorer, follow these steps:

· Right click on the project name

· Choose Add>New Item
· In the Add New Item window, select Jscript File
· In the name text box, name the file clear.js
Reference the JavaScript file
Before our page knows JavaScript is there, we need to reference the file. Let’s add the code to do this as shown below:

<head runat="server">

<title></title>

<style type="text/css" media="screen">

@import "styles.css";

</style>

<script type="text/javascript" src="clear.js">

</script>

</head>

As you can see from the code above, right below our ending style tag, we reference our JavaScript file.

Writing the JavaScript reset functionality
From the solution explorer, double click clear.js to open the file and add the following code as shown below:

function clear_Fields() {

    document.getElementById("fnameTB").value = '';

    document.getElementById("lnameTB").value = '';

    document.getElementById("emailTB").value = '';

    document.getElementById("ddlSeverity").options.length = 0;

    document.getElementById("ddlStatus").options.length = 0;

    document.getElementById("ddlDept").options.length = 0;

    document.getElementById("commentsTB").value = '';

    document.getElementById("ddlEmp").options.length = 0;

}
As you can see from the code above, we create a function named clear_Fields and inside we grab each of our controls by their unique id, and set their value to an empty string, except for our drop down lists, which we set to zero. Save your file(s). 
Run the project
Before we can preview the page, we need to add the code that’s associated to our submit button. Let’s add this by adding the code as shown below:

protected void btnSubmit_Click(object sender, EventArgs e)

  {

  }

Save your file. When we initially run the project, you’ll see this window show:
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Go ahead and click OK, and then you should be able to enter data in each control, press the clear button and each control should be reset to its initial value(s). Once you’re through, return to Visual Studio and press the Stop button (Shift + F5). Minimize Visual Studio for the time being.
Filling the drop down lists
Currently, the drop down list(s) are not populated with data from our database table(s). We have a few different approaches we can take, which are:

· Use a sql data source in our default.aspx file and then data bind directly to our drop down list 

· Create a new C# class, and use embedded SQL to query our data 

· Create a new C# class, and use a stored procedure to query our data

Using our first option has tradeoffs for two reasons: (1) You have a sql data source that has specific attributes and (2) you are data binding directly to a control directly in the ASPX page, which isn’t best practice. Using the second option would be ok, the only tradeoff is that you have SQL embedded in your application logic which is generally not a good thing, unless it’s referencing an interface or abstract class. Furthermore, if anything changes to that query, you don’t want to sift through application logic, that should be a change to the data access layer (DAL). Using the third option is the best, because we’re using a stored procedure which is SQL code that is executed as a function in our application logic. Plus, with this option, we’ll code the operation that gets the data against a generic list collection, which means if we ever needed to compile this class for global use, all a developer would need to do is a add a reference to the DLL and know what arguments it needs or returns. As a result, we’ll use the third option.

Stored procedures
Stored procedures in databases can be thought of as blocks of SQL code that have been executed against the database. This is great for multiple reasons including:

· Since the SQL code is executed against the database, it’s already indexed on the database and knows the tables it needs, which means performance is enhanced
· Since we’re calling the function in our application, we aren’t executing a SQL query from our application, which is faster than embedding SQL

· If a change is needed to the query, you change it in the saved SQL file, rather than in our business layer

Create the stored procedure for severities
If you still have the database on your task menu, simply restore it. From the object explorer, follow these steps to create the procedure for severity:
· Expand the plus sign (+) next to our database, mwd
· Expand the plus sign (+) next to programmability
· Expand the plus sign (+) next to stored procedures
· Right click on stored procedures and select new stored procedure
Modify the generated code, with the following as shown below:

use mwd
-- ================================================

-- Template generated from Template Explorer using:

-- Create Procedure (New Menu).SQL

--

-- Use the Specify Values for Template Parameters 

-- command (Ctrl-Shift-M) to fill in the parameter 

-- values below.

--

-- This block of comments will not be included in

-- the definition of the procedure.

-- ================================================

SET ANSI_NULLS ON

GO

SET QUOTED_IDENTIFIER ON

GO

-- =============================================

-- Author:

<Author,,Name>

-- Create date: <Create Date,,>

-- Description:
<Description,,>

-- =============================================

CREATE PROCEDURE spHelpDeskGetStatuses 


-- Add the parameters for the stored procedure here

AS

BEGIN


-- SET NOCOUNT ON added to prevent extra result sets from


-- interfering with SELECT statements.


SET NOCOUNT ON;

    -- Insert statements for procedure here


SELECT ID, Status


FROM Status

END

GO

As you can see from the SQL above, our stored procedure is named spHelpDeskGetStatuses and then we simply query our table, status. Before running the stored procedure on the database, from the main menu follow these steps to save the stored procedure:

· File>Save

Save your stored procedure to a location of your choice. Once completed, run the stored procedure by clicking execute right below the main menu. If ran succesfully, SQL server will report Commands executed successfully. Minimize SQL Server Management Studio for the time being.
Creating the severity class
From the task menu, restore Visual Studio. From the solution explorer, right click on the project and follow these steps:
· Add>New Item
· In the add new item window, select class
· In the name text field, type Severity.cs

· Click add.
Double click Severity.cs from the solution explorer, which will show the empty class as shown below:
using System;

using System.Collections.Generic;

using System.Linq;

using System.Web;

namespace HelpDesk

{

    public class Severity

    {

    }

}

In order to work with our SQL database, we need to import the following libraries as shown below:

using System;

using System.Collections.Generic;

using System.Linq;

using System.Web;

using System.Data;

using System.Configuration;

using System.Data.SqlClient;
namespace HelpDesk

{

    public class Severity

    {

    }

}

As you can see from the code above, we added three. The first allows us to work with stored procedures in ADO.NET, the second allows us to reference a connection key from our configuration file and the last allows us to connect to SQL server.
Creating our declarations
Let’s first add class level variables so that we can get or set our data. Add the following code as shown below:

namespace HelpDesk

{

    public class Severity

    {

        #region Declarations

        public int id { get; set; }

        public string severity { get; set; }

        #endregion

    }

}
As you can see from the code above, we added a region that holds our two class level variables. These two variables match our two columns from the database table.

Creating our method
From our default.aspx.cs file, it would be nice if we could create a generic container that could call a method in our class file, which in turn, calls a stored procedure, return the data and then bind to our drop down list. We can do this by creating a static method in our severity class that implements ICollection, which supports methods for dealing with collections of data, which is exactly what we have. Let’s add this code as shown below:
namespace HelpDesk

{

    public class Severity

    {

        #region Declarations

        public int id { get; set; }

        public string severity { get; set; }

        #endregion

        #region Methods

        public static ICollection<Severity> GetSeverities()

        {

            SqlConnection conn = new SqlConnection(ConfigurationManager.ConnectionStrings["mwd"].ConnectionString);

            SqlCommand cmd = new SqlCommand("spHelpDeskGetSeverities", conn);

            cmd.CommandType = CommandType.StoredProcedure;

            List<Severity> list = new List<Severity>();

            try

            {

                Severity s = new Severity();

                s.id = 0;

                s.severity = "--select one--";

                list.Add(s);

                conn.Open();

                SqlDataReader rdr = cmd.ExecuteReader();

                while (rdr.Read())

                {

                    Severity severity = new Severity();

                    severity.id = Convert.ToInt32(rdr["ID"]);

                    severity.severity = rdr["Severity"].ToString();

                    list.Add(severity);

                }

            }

            catch (Exception e)

            {

                throw new Exception(e.Message.ToString());

            }

            finally

            {

                cmd.Dispose();

                conn.Close();

            }

            return list;

        }

        #endregion

    }

As you can see from the code above, we did the following:

· Created a public static method, that is referencing ICollection, with a generic type of our severity class, followed by our method name

· Create a connection object, and pass in our configuration key from our web.config

· Create a command object and pass in our stored procedure we created earlier and connection object

· Set our command object to accept a stored procedure

· Create a generic list object with a type of our severity class

Before moving forward, let’s briefly discuss generics. A generic list object simply holds contents of data that isn’t type specific. Generics are great for dealing with collections of data. Instead of having to worry about casting to a specific type, such as an array list, or others, leave the data structure generic to a list object and you’ll make life much easier.


Continuing, if for any reason we can’t open a connection to the database or read through our data reader, we wrap it inside a try/catch block which handles exceptions. Inside our try block, we do the following:

· Create a new instance of our severity class, and set it’s property, id and severity to a constant value, then add it to our list object

· If our connection is successful, we execute the result set to our reader object, and while inside the loop we do the following:

· Create a new istance of the severity object

· Set each of its properties to the values from our database

· Once we finish with the loop, we dispose of our command object and close out connection

· Return our list object with its data

If you haven’t saved your file(s), now would be a good time to do so.
Creating the load combo boxes method

Even though we have created the class and stored procedure to retrieve our data, we haven’t “hooked”up the data to any control. Let’s use our severity class as our example. From the solution explorer, left click the plus sign (+) next to default.aspx and then double click default.aspx.cs and insert the code as shown below:

protected void LoadCombos()

{

   ICollection<Severity> severity = Severity.GetSeverities();

   ddlSeverity.DataTextField = "severity";

   ddlSeverity.DataValueField = "id";

   ddlSeverity.DataSource = severity;

   ddlSeverity.DataBind();

}
As you can see from the code aboe, we created a method named LoadCombos and then we do the following:

· Create a generic reference to ICollection and type it as our severity class

· Call our GetSeverities method from the severity class

· Set the DataTextField of our drop down list to our class property, severity

· Set the DataValueField of our drop down list to our class property, id

· Set the DataSource of our drop down list to our severity list object
· Call the DataBind method of our drop down list

In the page load event, let’s add the following as shown below:

protected void Page_Load(object sender, EventArgs e)

{

if (!IsPostBack)

      {

      
LoadCombos();

}

}

As you can see from the code above, if the data in the list hasn’t changed, we don’t need to “post back” to refresh the changes to the data. As a result, we wrap our LoadCombos method in this check to minize server hits.
Creating the other classes
We need to repeat the headings “create the stored procedure through creating the load combo boxes method” for the rest of our drop down list(s) as follows:

· Departments

· Employee

· Status

The best approach would be to create each stored procedure, then the class, and then repeat the code in LoadCombos, replacing reference names as appropriate.
Creating the help desk class
Now that we have our data coming in, we need to be able to record a help desk ticket submission. We need to create an event handler in a class to handle it. Let’s first create a help desk class by doing the following:
· Right click the project solution

· Choose Add>New Item
· In the Add New Item window, select Class.cs
· In the name text field, type HelpDesk and then click Add
Double click HelpDesk.cs from the solution explorer, which will show the empty class as shown below:

using System;

using System.Collections.Generic;

using System.Linq;

using System.Web;

namespace HelpDesk

{

    public class HelpDesk

    {

    }

}

We need to import the following libraries as shown below:

using System;

using System.Collections.Generic;

using System.Linq;

using System.Web;

using System.Data;

using System.Configuration;

using System.Data.SqlClient;
namespace HelpDesk

{

    public class HelpDesk

    {

    }

}

As you can see from the code above, we added three. The first allows us to work with stored procedures in ADO.NET, the second allows us to reference a connection key from our configuration file and the last allows us to connect to SQL server.
Creating our declarations
Let’s first add our class level variables so that we can get or set our data. Add the following code as shown below:

namespace HelpDesk

{

    public class HelpDesk
    {

        #region Declarations

        public string fname { get; set; }

        public string lname { get; set; }

        public string email { get; set; }

        public int status { get; set; }

        public string comments { get; set; }

        public int severity { get; set; }

        public int department { get; set; }

        #endregion

    }

}

As you can see from the code above, we added a region that holds our class level variables. These variables match our columns from the database table.

Creating our method
In order to insert our help desk ticket, we need one method that will accept our parameters and insert the record. We do this by adding the following code:

#region Methods

        public void Save()

        {

            SqlConnection conn = new SqlConnection(ConfigurationManager.ConnectionStrings["mwd"].ConnectionString);

            SqlCommand cmd = new SqlCommand("spInsertHelpDeskTicket", conn);

            cmd.CommandType = CommandType.StoredProcedure;

            SqlParameter parameterFName = new SqlParameter("@FName", SqlDbType.VarChar, 50);

            parameterFName.Value = fname;

            cmd.Parameters.Add(parameterFName);

            SqlParameter parameterLName = new SqlParameter("@LName", SqlDbType.VarChar, 50);

            parameterLName.Value = lname;

            cmd.Parameters.Add(parameterLName);

            SqlParameter parameterEmail = new SqlParameter("@Email", SqlDbType.VarChar, 50);

            parameterEmail.Value = email;

            cmd.Parameters.Add(parameterEmail);

            SqlParameter parameterSeverity = new SqlParameter("@SeverityID", SqlDbType.Int);

            parameterSeverity.Value = severity;

            cmd.Parameters.Add(parameterSeverity);

            SqlParameter parameterStatus = new SqlParameter("@StatusID", SqlDbType.Int);

            parameterStatus.Value = status;

            cmd.Parameters.Add(parameterStatus);

            SqlParameter parameterDepartment = new SqlParameter("@DepartmentID", SqlDbType.Int);

            parameterDepartment.Value = department;

            cmd.Parameters.Add(parameterDepartment);

            SqlParameter parameterComments = new SqlParameter("@Comments", SqlDbType.VarChar, 250);

            parameterComments.Value = comments;

            cmd.Parameters.Add(parameterComments);

            try

            {

                conn.Open();

                cmd.ExecuteNonQuery();

            }

            catch (Exception e)

            {

                throw new Exception(e.Message.ToString());

            }

            finally

            {

                cmd.Dispose();

                conn.Close();

            }

        }

        #endregion

As you can see from the code above, we do the following:

· Create a connection object and pass in our configuration key

· Create a command object and pass in our stored procedure

· Set our command object to use a stored procedure

· Create a sql parameter for each class level variable

· Specify the data type for each

· Add each sql parameter to our command object

If for any reason we can’t open or execute our query, we wrap it inside a try/catch block and do the following:
· Open the connection to our database

· Execute the stored procedure

Once executed, we dispose of the command object and close our connection.

Create the help desk object

From the solution, double click default.aspx.cs and type the following method as shown below:

namespace HelpDesk

{

 public partial class _default : System.Web.UI.Page
 {

     #region Declarations

     HelpDesk hd = new HelpDesk();

     #endregion
     protected void Page_Load(object sender, EventArgs e)

  {

  }

  protected void btnSubmit_Click(object sender, EventArgs e)

  {

  }

 }

}

As you can see from the code above, we simply create a reference to the help desk object.

Creating the submit method
Since we have the reference to our help desk object, let’s add the following method as shown below:

protected void btnSubmit_Click(object sender, EventArgs e)

        {

            hd.fname = fnameTB.Text;

            hd.lname = lnameTB.Text;

            hd.email = emailTB.Text;

            hd.severity = Convert.ToInt32(ddlSeverity.SelectedValue);

            hd.status = Convert.ToInt32(ddlStatus.SelectedValue);

            hd.department = Convert.ToInt32(ddlDept.SelectedValue);

            hd.comments = commentsTB.Text;

            hd.Save();

            phForm.Visible = false;

            phSuccess.Visible = true;

        }

As you can see from the code above, we set each of our help desk object properties to the appropriate values of our controls from our default.aspx page. Once we have that information, we call the save method, and then we toggle the visibility of our controls.

Test drive the application
From visual studio, click the green arrow button (F5) to run the project. Type in data to the text fields, pick optons from the drop down lists and press submit; if everything goes right, you should have a new record in the help desk table.
Summary
In this article you learned how to build a relatively simple help desk application in ASP.NET. You learned how to do the following:

· Create a database

· Corresponding tables

· Create and understand stored procedures

· Understand relationships with data

· Create a database diagram to enforce referential integrity

· Create a Visual Studio project

· Create a web form with basic controls

· Create java script reset functionality

· Create corresponding C# classes, and understand the basics of generics
· Create server or client side event handlers and understand the differences between the two

Take the knowledge you gained from this article and expand your help desk application to meet any requirement you may need.

If you have questions, please contact me.

